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1.0 Installation
To connect the Configurator to the Fire Alarm Control Panel you must:

• Install the Configurator.

• Insert the Wibu key.

• Connect the cable.

• Start the Configurator.

Follow the instructions below to complete these steps.

1.1 Install the MGC-3000 Configurator

You need the following items in order to install the Configurator:

• Windows 7 or Windows 10 computer with a USB port.

• MGC-3000 Series Configuration Utility (the Configurator).

Follow these instructions to install the Configurator.

1. Right-click the MGC-3000_Configurator icon, and then click Run as Administrator.

The Setup program starts.

Figure 1 Setup - MGC-3000 Configurator
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2. Click I accept the agreement to accept the agreement, and then click Next.

The Ready to Install window appears.

Figure 2 Ready to Install

3. Click Install.

4. The FTDI CDM Drivers window appears. These drivers are necessary for connecting to 
the panel with a USB cable.

Figure 3 FTDI CDM Drivers
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5. Click Extract and follow the instructions on the screen to install the drivers.

6. After the FTDI drivers have been installed, the WibuKey Setup window appears. The 
Wibu key is a USB flash drive that provides security by controlling access to the Fire 
Alarm Control Panel.

Figure 4 WibuKey Setup

7. Click Next and follow the instructions on the screen to install the WibuKey software.

After the WibuKey drivers have been installed, the last screen of the MGC-3000 Setup 
Wizard appears.

Figure 5 Completing the MGC-3000 Configurator 2022 Setup Wizard

8. Click Finish.
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1.2 Insert the Wibu key

1. Insert your Wibu key into the computer.

If a Security Key Logon window appears that says that your security key is an older 
version, you must contact your ESD Administrator or Mircom technical support to 
upgrade your key. Otherwise, you might not be able to connect to the FX-3500/
3500RCU.

1.3 Connect the Computer to the Panel through the Micro-USB 
Port

You need:

• USB A male to micro-B male cable.

Figure 6 The core board

1. Connect the USB cable to a USB port on the computer, and to the USB port on the FX-
3500/3500RCU plug-in core board. This port is labeled P5.

2. Go to section 1.5 on page 19.

Attention: Follow the instructions in this section only if the panel’s plug-in core 
board has a sticker showing “SO-289 v3.0.1” (or a number higher than 
3.0.1). The plug-in core board is shown in Figure 6.

If the panel’s plug-in core board does NOT have a sticker showing 
“SO-289 v3.0.1” (or a number higher than 3.0.1), follow the instruction in 
section 1.4 on page 13.

!

Green core boardNew red core board

��� ���

���	
������
	�
JW4

JW5
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1.4 Connect the Computer to the Panel through the Main Board

You need:

• MGC-CONFIG-KIT4 Fire Panel Configuration Kit (this kit includes the cables required to 
connect the laptop computer to the Fire Alarm Control Panel)

1.4.1 Connect the Laptop to the Panel

1. Connect the laptop to the panel using one of the methods shown below. The method 
shown in Figure 7 is recommended.

Figure 7 USB A to B male cable to P13 on main board

Figure 8 UIMA4 to P5 on main board

Figure 9 UIMA to P5 on main board

2. Follow the instructions starting in section 1.4.2 on page 14 to configure Windows.

Attention: These instructions describe how to connect to the panel if the panel’s 
plug-in core board does NOT have a sticker showing “SO-289 v3.0.1” 
(or a number higher than 3.0.1).

If the sticker on the core board DOES show “SO-289 v3.0.1” (or higher), 
you have the option of connecting to the panel with a micro-USB cable, 
as described in section 1.3 on page 12.

!

Computer FACPUSB A to B male cable

Computer UIMA4 interface FACPUSB A to B male cable

USB connector 10 pin connector

Serial cable UIMA interface
FACP

Computer
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1.4.2 Start the Windows Device Manager

Start the Device Manager in Windows 7

1. Open the Windows Control Panel.

2. Click Device Manager on the left.

The Device Manager window appears.

• If you are using a USB cable (Figure 7), go to section 1.4.3.

• If you are using a UIMA cable (Figure 8 or Figure 9), go to section 1.4.4 on page 17.

Start the Device Manager in Windows 10

1. In the search field, type Device Manager, then press Enter.

The Device Manager window appears.

• If you are using a USB cable (Figure 7), go to section 1.4.3.

• If you are using a UIMA cable (Figure 8 or Figure 9), go to section 1.4.4 on page 17.

1.4.3 Configure the Device Manager for USB

1. In the Device Manager, click the plus sign (+) or arrow ( ) beside Mice and other 
pointing devices.

Figure 10 Device Manager

Attention: If you connect more than one FX-3500/3500RCU panel to the same 
computer over USB, always use the same physical USB port on the 
computer. Otherwise, every time that you connect a panel to a different 
port, you must complete the steps in this section.

In addition, if you connect more than one FX-3500/3500RCU panel to the 
same computer, do not use a USB 3 port. Otherwise, every time that you 
connect a new panel to the USB 3 port, you must complete the steps in 
this section.

!
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2. Right-click Microsoft Serial Ballpoint, and then click Disable in the pulldown menu.

A window appears warning that disabling this device will cause it to stop functioning.

3. Click Yes.

Figure 11 Microsoft Serial Ballpoint

An X (a downward pointing arrow in Windows 8) appears over the Microsoft Serial 
Ballpoint, showing that is it disabled.

Figure 12 Microsoft Serial Ballpoint Disabled

4. In the Device Manager window, click the plus sign (+) or arrow ( ) beside Ports.

Figure 13 USB Serial Port in the Device Manager
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5. Right-click USB Serial Port, and then click Properties in the pulldown menu.

If there is more than one USB Serial Port, click the one that you are using to connect to 
the FX-3500/3500RCU.

The USB Serial Port Properties window appears.

Figure 14 USB Serial Port Properties

6. Click the Port Settings tab.

The Port Settings window appears.

Figure 15 Port Settings
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7. Click Advanced.

The Advanced Settings window appears.

Figure 16 Advanced Settings

8. Click the pulldown menu beside Receive (Bytes), and then click 64.

9. Click the pulldown menu beside Transmit (Bytes), and then click 64.

10. Click the pulldown menu beside Latency Timer (msec), and then click 1.

11. Uncheck the checkbox beside Serial Enumerator.

12. Click OK to close the Advanced Settings window.

13. Click OK to close the USB Serial Port Properties window, and then close the Device 
Manager window.

14. Go to section 1.5 on page 19.

1.4.4 Configuring the Device Manager for a Serial Connection

1. In the Device Manager window, click the plus sign (+) or arrow ( ) beside Ports.

Figure 17 COM Port in the Device Manager

8.
9.

10.
11.
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2. Right-click the COM communications port, and then click Properties in the pulldown 
menu. It is usually labeled Communications Port (COM1).

If there is more than one COM communications port, click the one that you are using to 
connect to the FX-3500/3500RCU.

The Communications Port Properties window appears.

Figure 18 Communications Port Properties

3. Click the Port Settings tab.

The Port Settings window appears.

Figure 19 Port Settings
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4. Click Advanced.

The Advanced Settings window appears.

Figure 20 Advanced Settings

5. Drag the slider beside Receive Buffer to the far left.

6. Drag the slider beside Transmit Buffer to the far left.

7. Click OK to close the Advanced Settings window.

8. Click OK to close the Communications Port Properties window, and then close the 
Device Manager window.

9. Go to section 1.5 below.

1.5 Start the Configurator

1. Start the Configurator, then click File, then click User Preferences.

2. Enter your name in the User Name field.

3. In the Serial Port menu, select the COM port that the USB cable is using.

Figure 21 Select the COM port in User Preferences
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4. Click OK to close the User Preferences window.

5. Click Panel, then click Connect.

The Connection window appears.

Figure 22 Connection

6. Click Connect.

You are now connected to the panel. Go to section 3.0 on page 22.
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2.0 User Preferences
The first time the Configurator starts, the User Preferences window appears.

Figure 23 User Preferences window

These values are stored in the registry (per Configurator version) so that a returning user 
operates in the same folders, etc. 

On the first execution of the Configurator this dialog is popped up automatically to establish 
these values. It can be used at any time thereafter to change the settings.

User Name Used for the Author of all new jobs and job versions.

Serial Port Designates which COM port (or USB pseudo COM port) the 
Configurator will use to connect to the panel. To accommodate 
machines with multiple (pseudo) COM ports, the list will be 
extended. It currently only shows serial ports COM1-COM4.

Security Key Port: Lists the ports where a Wibu key can be inserted. The Wibu 
key is required.

BDM Port Designates which parallel port the Background Debugging Module 
will use (for those products that support this interface).

Database Folder Specifies where the main Configurator.mdb database file resides. 
Usually the folder where the Configurator is installed. 

Job Edit Folder Specifies where individual job files are extracted to/imported from.

Job Build Folder Specifies where the 'C' file output files are written by Job Validate 
and other trace or debug facilities. 

Backup Folder Specifies where backup database files are written to and restored 
from. 

Show Tools Menu Display or hide an additional Tools menu. This menu contains 
trace and debug facilities and some features that Technical 
Support may require a user to turn on to gather diagnostic 
information. 

Keep Only Latest Versions 
After Backup

If enabled, only the latest versions of all jobs will be kept after a 
successful Backup Database command, all older versions are 
removed from the current database. 
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3.0 Overview
In order to operate as a fire alarm, a fire alarm panel must be loaded with firmware and 
configuration data. A set of configuration data, used to uniquely describe and control a given 
set of hardware, is called a Job. The Configurator allows the user to create and manage jobs. 
It also allows the user to send firmware to a panel and all its related nodes and CPUs.

The Configurator is typically run on a portable notebook or laptop computer that is taken to the 
job site and connected to the panel. The technician prepares a job using the Configurator’s 
Graphical User Interface (GUI). The job can then be sent to the panel. The same or a different 
authorised technician can later retrieve the job from the panel, modify it and send it back.

The job repository is a Relational Database (MS-Access). Jobs can be imported or merged 
from another database, copied, deleted, and archived in various formats. A job can be printed, 
or two versions of a job can be compared.

A wizard driven program installs the product. On the first use of the Configurator the user is 
prompted for the paths and file names where jobs, backup, the database, etc. are to be stored. 
Registry entries remember many of the user’s preferences.

The configuration software runs on a Personal Computer (PC) and the jobs can be transferred 
to the panel in one of three ways. Jobs can be transferred through a USB connection directly 
to the panel from the PC, through a Universal Interface Module Adapter (UIMA) connection 
from the PC serial port to the 10 pin P5 port on the main board, or remotely using a dial-up 
modem to connect to the on-board dialer.

3.1 GUI - Major Components

The Configurator uses a familiar Microsoft Windows Graphical User Interface (GUI) to present 
a job. The screen is divided into (max.) three panes.

Figure 24 GUI Panels
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3.1.1 Job Tree

On the left of the screen, the job is represented as a tree, similar to a file explorer. At the 
highest level in the tree are the CPUs or Nodes. Under each node are its components - 
Annunciators, Loop Controllers, etc. Some items are further subdivided, for example, an 
annunciator into display adders and a loop controller into loops.

Some items in the tree do not directly represent a physical component. For example, tree 
nodes exist for input and output summaries and for common controls.

3.1.2 Details

The top right pane is used to display the details of the currently selected tree node. This can 
be a form view or a list view. For example, this pane is used to list the devices on a loop 
controller (list view) and to display the options and messages of a main display (form view).

3.1.3 Correlations

The third, bottom right pane is used to show correlations from an item selected in the top right 
pane, where appropriate. For example, when a loop is selected in the tree, the top right pane 
would show all of its devices or circuits. When one or more input circuits are selected in the 
list, then the bottom pane would show the output circuit(s) to which this is correlated.

A standard (File, Edit, etc.) and specialized (Job, Panel, Tools) menu hierarchy is provided for 
such functions at Create New Job, Delete Job, Connect to Panel, etc.

A tool bar provides convenient short cuts to the more frequently used functions

Standard keyboard short cuts and mouse operations are supported for such things as copy 
and paste, drag and drop, etc.

3.2 Related Documents

For information on releasing applications for the FX-3500RCU, see the latest version of LT-
1091 FX-3500RCU Releasing Application Guide on http://www.mircom.com/.
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4.0 Menus

4.1 File Menu

The File Menu contains the following commands:

4.2 Job Menu

The Job Menu contains the following commands:

Table 1 File Menu

Name Short cut Description

Backup 
Database

Backup database makes a copy of the Master Database in the File 
folder specified in the User. The backup file will have a name of the 
form YYYY-MM-DD.mdb. The back up can be used by the Restore 
Database command to recover all of the jobs in the database. It can 
also use the Import command to recover selected jobs. Backup your 
Master Database often and store a copy of the resulting file on a CD 
or other media.

Restore 
Database

Restores the backup database to the active database directory for 
use or modification. This will overwrite the existing database and 
will return the database to the date the backup was made. 

Compact 
Database

To ensure optimal performance, you should compact and repair your 
database on a regular basis. If you have purged job versions or 
deleted jobs, Compacting the Database will regain the space 
occupied by those records.

User 
Preferences

Specifies User Preferences, such as the location of database, 
backups, job files, etc. 

Print

Ctrl+P

Print the active job.

Print Preview Display a Print Preview of the active job.

Print Setup Select the printer, paper size and orientation for a print job.

Exit Closes the Configurator.

Table 2 Job Menu

Name Short cut Description

New Job

Ctrl+N

This command will open the Create Job dialog which will allow you 
to start a new job. The new job can be based on a supplied template 
or on an existing job.

Open Job

Ctrl+O

This command will open an existing job from your database.
24



4.3 Insert Menu

The Insert Menu contains the following commands.

Some commands may be disabled (greyed) depending on what items are selected on the user 
interface.

Import Job Imports a selected job/version from an external database or 
serialized job archive and converts the job to the current version if 
necessary.

Export Job
Ctrl+E

Exports the current job in one of two formats: A single job database 
file, or a compact, serialized archive format.

New Version

Ctrl+W

Make a copy of the current job, assigning it the next highest version 
number. The user is prompted for mandatory comments and may 
also override the Author field. The Job Name cannot be changed. 
The new version is un-locked for editing. 

Delete Job 
Version

Ctrl+D
This command permanently deletes the current Job / Job Version 
from the database.

Version 
History

Display the Version History (Date, Author, Comments) for the current 
job. 

Compare Job 
Versions

Compare two versions of the same job, or two similar jobs of 
different lineage. 

Validate Job This action performs all of the steps normally performed when 
preparing to send a job to the panel. 

Edit Job Toggle the lock on a job that is protected against unintentional edits 
or has been down loaded to a panel. 

Table 3 Insert Menu

Name Description

Add Loop Controller Add an Addressable Loop Controller to the job

Add Annunciator Add an LCD or LED Annunciator to the job.

Add Display Adder Add a Display Adder to an Annunciator or Base Panel.

Add Device If the selected tree item is a device loop, launch a dialog to add a device.

Add Group If the selected tree item is Bypass Groups, add a new bypass group to the 
Bypass Group view.

Add Correlations Launch a dialog that allows correlations to be added to the selected 
devices or display items

Table 2 Job Menu (Continued)

Name Short cut Description
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4.4 Edit Menu

The Edit Menu contains the following commands.

Some commands may be disabled (greyed) depending on what items are selected on the user 
interface.

4.5 Panel Menu

The Panel Menu contains the following commands:

Table 4 Edit Menu

Name Short cut Description

Delete Item Del Deletes the currently selected item.

Modify Item
Ctrl+M

If the currently selected item is a row in an editable list, then the first 
changeable cell is selected and prepared for editing.

Copy

Ctrl+C

Copies the selected item(s) to the clipboard.

Paste

Ctrl+V

Pastes items from the clipboard to the selected destination. 

Paste Special

Ctrl+Shift
+V

Similar to Paste: Opens the Paste Special dialog to allow defaults to 
be changed before pasting.

Table 5 Panel Menu

Name Short cut Description

Connect

Ctrl+L

This command will establish a connection between the configuration 
tool and the panel, enabling most of the other commands in this 
menu. Remember to disconnect when you are finished, as a trouble 
will be indicated on the fire alarm panel as long as the laptop is 
connected.

Send Job Ctrl+S Sends the job to the panel.

Get Job

Ctrl+G

Get the job from the panel and store it on the configuration tool's 
database. The job becomes the current job, shown in the user 
interface.

Panel 
Information

Displays detailed information about the panel to which the 
configuration tool is connected.

Security Key 
Info

Displays a dialog with the security key information such as serial 
number, expiry date, number of uses, etc.

Event Log Displays a list of events from the panel.
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4.6 Tools Menu

The items under the Tools Menu are used mainly for troubleshooting and diagnostic purposes 
by the factory.

Upgrade 
Firmware

Opens a wizard which guides the user through the firmware upgrade 
process.

Table 6 Tools Menu

Name Short cut Description

Extract All DB Extracts the latest version of every job to individual database files.

Validate All Ctrl+S Validates the latest version of every job on the database.

Build Job
Ctrl+B

Builds the job, assuming the latest product version, creating a ".c" 
file in the Job Build folder.

Build Job (old 
version)...

Builds the job ".c" file for a specified, older product version.

Link Statistics Displays the connection link statistics.

Log Send Toggle the current state of the "dump on send" option. Causes the 
".c" file to be produced and dumped on a Get Job.

Log Get Toggle the current state of the "dump on get" option. Causes the ".c" 
file to be produced and dumped on a Send Get.

Log Comms Toggles logging of serial communications.

Trace Toggles the current state of the trace option. When turned on this 
causes debug information to be written to a trace file.

Display 
Structure

This command will display a dialog that will allow you to view and log 
panel data structures.

External Bus Toggles the "Use External Bus" setting. When turned on, this signals 
that the Configurator is connected to the External Bus of the panel.

Note: The Tools menu is only available if you checked the Show Tools Menu option. 
See User Preferences.

Table 5 Panel Menu (Continued)

Name Short cut Description

i
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4.7 Quick Bar

Table 7 Quick Bar Icons

New Job

Select Job and 
Version

Toggle Edit Job

Copy

Paste 

Paste Special

Delete

Print

Compare Jobs

Connect

Send Job

Get Job

Panel Info

Security Key

About

Help On
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5.0 Job Tree and Details Pane
The Job Tree lists the following:

• Job Details

• Base I/O and associated Loops

• Bypass Groups

• Output Groups

• Hazard Zones

• Main Display and associated Display Adders

• Dialer

• Common System Status

• Input Summary

• Output Summary

Depending on what is selected in the Job Tree, the Details Pane will dynamically display 
relevant information.

5.1 Job Details

Figure 25 Job Details

5.1.1 Job Info

Shows details of the job's name, number, creation date and author. The multi-line comments 
field can be edited and become part of the job's version history.
29



5.1.2 Language

Specifies the language used to display system messages on the front LCD display and on any 
LCD annunciator. User defined tags and messages will not be affected.

5.1.3 Options

Manual Signal Silence Check to enable the panel's Signal Silence switch.

Fire Drill Check to enable the panel's Fire Drill switch.

Waterflow Retard Operation If disabled, all the initiating circuits configured as waterflow act as 
non-verified alarms. If enabled, retard operation is performed for 
initiating circuits configured as waterflow.

Auxiliary Disconnect Alarm 
and Supervision

If enabled the auxiliary disconnect operation, disconnects alarm 
and supervisory relays disabled the auxiliary disconnect operation 
has no effect on the alarm and supervisory relays.

Alarm Transmit Silence This feature, if checked, causes the Alarm Transmit and Auxiliary 
Alarm Relay to reset on Signal Silence rather than by the Reset 
switch.

Disable Auto Test This feature lets you change the NFPA device periodical self-test 
to enabled or disabled.

Common Supervisory Relay This feature, if checked, makes the common supervisory relay act 
as a common alarm relay.

Signal Isolator Used Check this box if isolators are present on the loop 0 powered 
output circuits.

Two Stage Operation Check this box to configure the system as two stage, else it is 
single stage.

Second Stage Alarm Relay 
Operation

If enabled, the common alarm relay will be used for second stage 
only of a two stage system. If disabled, it will be used for both 
stages.

Positive Alarm Sequence Check this box to enable the Positive Alarm Sequence feature. It 
only applies to alarm input devices with the PA flag (F2) set. This 
feature cannot be enabled if Two Stage Operation is enabled.

Building Alert Check this box to have the panel produce alert sounds on building 
(monitor) in/out activation.

Polled Device Flashes Check this box to cause device LEDs to flash when polled.

Class-A Loop Check this box if the addressable loop on the base panel operates 
in Class A mode.
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5.1.4 Timers

Class-A CLIP Inputs Check this box to enable Class A mode for all CLIP input modules.

Strobes Type Specify the Strobe Type that will be used on the panel.

• Gentex

• System Sensor

• Mircom

• Wheelock

Evacuation Code Specify the Evacuation Code that will be used on the panel.

• Continuous

• March Time

• Temporal

• California

Agency Selection Specify the Agency Standard that will be used on the panel.

• ULI Standard

• ULC Standard

Table 8 Timers

Timer Type Possible Settings

Signal Silence Inhibit Disabled, 10, 20, 30 seconds, 1 minute

While this timer is running, you cannot silence the alarm or reset 
the system.

Auto Signal Silence Disabled, 5, 10, 15, 20, 30 minutes. This timer cannot be set 
shorter than then General Alarm or Signal Silence Inhibit timers.

This timer specifies the amount of time after which the alarm is 
automatically silenced.

New Alarm (Secs) 10, 20, 30, 40, 50, 60, 70, 80, 90, 100, 110, 120 seconds

This feature is used to satisfy the requirements of Division B, Part 
3.2.4.18 of the National Building Code of Canada 2015, and the 
Ontario Building Code 2016 section 3.2.4.20(13), with respect to 
automatic suite silence. Signals that are correlated to the New 
Alarm Active Common System Status go active for the indicated 
amount of time and then go silent. The alarm continues to play on 
the outputs correlated with the zone or input that started the alarm.

General Alarm Disabled, 5, 10, 15, 20, 25, 30 minutes. This timer is disabled 
unless Two Stage Operation is selected.

Power Fail Delay 0, 1, 2, 3 hours. If the only trouble is an AC power failure, this is 
the amount of time after the power failure that the system delays 
transmission of status to the monitoring station.
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5.1.5 Date and Time

5.1.6 Holidays
This dialog allows you to add and remove holiday definitions for use when a panel is 
configured by checking the Enable Auto After Hours option.

Figure 26 Holidays Window

Auto Resound (Mins) 5, 6, 7, 8, 9, 10, 11, 12 minutes

This feature is used to satisfy the requirements of Division B, Part 
3.2.4.18 of the National Building Code of Canada 2015, and the 
Ontario Building Code 2016 section 3.2.4.20(13), with respect to 
automatic suite silence. This timer starts when the New Alarm 
timer expires. It specifies the time after which the signals that are 
correlated to the Auto Suite Resound Common System Status 
will activate again if the alarm remains unacknowledged.

Enable Daylight Savings Enable Daylight Savings.

Clock Daily Compensation Specify the number of seconds (signed) to be applied daily to the 
panel clock.

Enable Auto After Hours Check this to enable after hours. Use the following controls to 
configure after hours settings.

Holidays - Modify Compose a new holiday definition in the YYYY MM DD edit boxes 
and press Add holiday. You can specify recurring holiday by using 
wild cards. For further instructions on adding/deleting holidays see 
section 5.1.6 on page 32.

Daytime Start and End 
Hours

Specify when daytime begins and ends.

Weekend Start and End 
Hours

Specify when the weekend begins and ends.

Table 8 Timers (Continued)

Timer Type Possible Settings
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To add a new holiday

1. Compose a new holiday definition in the YYYY MM DD edit boxes.

2. If the holiday lasts longer then one day change the value in the Duration edit box to the 
desired length. 

3. Click Add Holiday and the holiday will be added to the Holidays defined list. 

To specify recurring holidays

Recurring holidays can be specified by using wild cards.

For a holiday that happens once a year enter 9999 in the YYYY edit box. 

• e.g. 9999 01 01 for New Years Day. 

Enter 99 for a month or day to specify a recurring holiday. 

• e.g. 9999 99 01 to specify that the first of every month is a holiday. 

• e.g. 9999 07 99 to specify that the plant is shut down for the whole of July for summer 
vacations.

As holidays are added or removed, the list on the "parent" form is maintained to be in 
agreement. An error message is displayed if the limit for the total number of holidays would be 
exceeded. 

To remove a holiday

1. Select the desired date from the Holidays defined list and press Delete Selected 
Holiday and the holiday will be removed.

2. Press Close to return to the Job Details form. 

5.1.7 Port Settings

5.2 Base I/O

Used to set the starting address for AP Devices. If the address is set to 1 CLIP devices are not 
permitted to be used.

Note: The program prevents you from entering duplicate holidays, but does not check 
for "nested" holidays.

Port Protocol None, Printer, OpenGN

Port Baud Rate 2400, 4800, 9600, 19200

Note: When mixing modes every address assigned to CLIP removes the equal amount 
of addresses from the Advanced Protocol addressable sensor and addressable 
module range.

i

i
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Figure 27 Base I/O Details

5.3 Loops

The list view displays the hard wired (Conventional) circuits or addressable devices of a Loop, 
when that loop is selected in the tree. The base set of columns is the same for both, but there 
are some Product and Loop Type dependencies.

Some columns containing advanced or internal information are normally hidden. They are 
listed as Visible / No in the following table. Other columns are conditionally visible. There are 
up to three Flag columns (F1, F3 and F4) for flags of various types.

Table 9 Loop Details

Name Visible Description

Addr Yes 
For regular addressable devices, the displayed address is the 
same as device address. For conventional circuits display adder & 
circuit on adder.

Lp No Loop Number.

Ckt No No 
An internal, sequentially assigned number. One set for inputs, 
another for outputs. 

Device Yes 

Conventional: fixed hardware loop circuits.

Addressable: chosen when Adding Device(s). Can be edited 
conditionally. 

Type Yes 

The process Type of the Device. Can be edited (combo box). The 
list of Types shown in the combo box will depend on the Device. 
For example, relay modules can be assigned Relay, Signal or 
Strobe.

Sens 
On Addressable 
Loops 

The sensitivity of various sensors. Displays a combo with 
percentage equivalents of internal absolute values. Takes into 
account jurisdiction (ULI vs. ULC). 

Sens B 
On Addressable 
Loops 

The after hours and night time sensitivity of a system configured to 
have the after hours option. 
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5.4 Bypass Groups

The list view displays the list of bypass groups currently defined in the system. You can 
correlate any input or output device to a group, as well as an LED to indicate its status. Once 
an LED is correlated to a bypass group, it will be used exclusively to indicate the status of that 
group and it can not be used for other purposes.

See section 6.12 on page 47 for instructions on configuring a display adder to operate a 
bypass group.

Some columns containing advanced or internal information are normally hidden. They are 
listed as Visible / No in the following table.

Tag1 Yes 
The text of the tag, in two 20 character fields, representing the 
lines displayed on the front panel when an alarm occurs, etc.

Table 10 Flag Columns - F1, F2, F3

Name Description

NS Non Silenceable: used on inputs and supervised Outputs.

NF Keeps the device LED off when device is active.

NB Non Bypassable used on relays.

GA 2nd Stage Alarm: used in a two stage system.

RR Rate of rise. For heat/thermal detectors only. It indicates that alarm activation of this 
device is based on the Rate of Rise algorithm. 

AR Auxiliary Reset required: used on relays. A relay with the AR flag will be latched after 
activation. In order to clear the activation, the operator must press a switch. The 
switch is wired to an input module which has the Auxiliary Reset Type.

CA Class A wiring. For zone modules and monitor modules. It indicates that the wiring of 
this device is Class A.

HV High volume: used on sounder bases.

Table 11 Bypass Groups

Name Visible Description

No. Yes Group number of the bypass group

Tag Yes Label of the bypass group

Table 9 Loop Details (Continued)

Name Visible Description
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5.5 Output Groups

Output groups let you specify a group of Advanced Protocol relay modules, control modules, 
and sounder bases that you want to activate simultaneously.

The Fire Alarm Control Panel uses the Advanced Protocol broadcast command to 
simultaneously activate all relay modules, control modules, and sounder bases that are in the 
same output group when there is a general alarm or fire drill.

5.5.1 Add Output Devices to an Output Group

1. Click Output Groups in the Job Tree under Base I/O.

2. Click Insert in the menu bar, then click Add Group.

The new output group appears in the Details pane.

3. Select the new output group.

4. Click Insert in the menu bar, then click Add Correlations.

The Select items to add window appears.

Figure 28 Select items to add to output group

5. Select the output devices that you want to add. To select more than one device, hold 
down the Ctrl key and click the devices.

6. Click Add.

7. Click Close.

Attention: You must configure all outputs in an output group to activate at the 
same time. If one of the outputs is not configured to activate when the 
other outputs activate, then the output group as a whole will not 
activate.

!
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5.6 Hazard Zones

The Hazard Zone area displays any configured Hazard zones with the following information.

5.7 Main Display

This form view appears in the top, right pane when the Main Display item is selected in the Job 
Tree view.

5.8 Display Adder

This list view appears in the top, right pane of the user interface when a display adder is 
selected in the Job Tree. The list displays items (LEDs and Switches) of all the frames on the 
selected Display Adder.

No. Number of the Hazard Zone.

Zone Label Label of the Hazard Zone.

Type Configured as Pre-Action/Agent or Deluge.

Counting 
Zone Type

Configured as Single, Double, Triple, 2 Input Type.

Abort Type Configured as ULI, IRI, NYC, AHJ.

Rel Delay The maximum value for the RDT is 60 seconds.

Soak Delay The maximum value for the SDT is 600 seconds.

Man Rel Delay The maximum value for the MRDT is 60 seconds.

Man Rel 
Priority

To ensure a Manual Release Switch overrides an Abort Switch, in the 
MGC-3000 configuration software set the Man Rel Priority flag for the 
Hazard Zone zone to Yes.

User 
Messages

System Normal: specify the message to display on the front panel LCD 
when the system is currently normal (no alarm or trouble). 

Passcodes Level 1: Not required

Level 2 and 3: Specify the passcode for each level of access. Passcodes 
must be numeric and a maximum of 20 digits long. 

Access Levels Specify the level of access for various front panel actions.

Level 1 does not require a passcode but a key to the panel is required

Level 2 is similar to Level 1 with additional access to disable zone 
function, fire alarm devices, sensitivity, time and date settings

Level 3 has access to all functions

Table 12 Display Adder Info

Name Visible Description

Idx Yes Index: the zero based position of the item on the adder.

CPU No 
The CPU Number of the Annunciator to which the adder is 
attached.
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5.9 Dialer

This form is displayed when the Dialer tree item is selected. It allows you to configure the 
UDACT / Dialer. The dialer can dial out on two phone lines. You must configure an account 
and specify the line attributes for both. Line 2 can dial a cell phone. If this is the case the auto 
test can be reduced from daily to monthly.

5.9.1 Account 1 

Unnamed Yes 

Linked Item: contains an asterisk if the item shares the same 
LedGrp with other items. This means that correlations to one such 
item are added to all linked items. Linked Items can be created 
when Paste Special is used. The linked items can be viewed with 
the Linked Items dialog.

Frame No 
The Frame Number. An adder may contribute several frames to an 
annunciator. The frame numbers are zero based.

LED No 

The number (zero based) of the first LED of a logical group. For 
example, an HOA adder has three LEDs per slide switch. This 
column would show 0 for Idx 0, 3 for Idx 1, etc. Due to the way 
some adders are arranged (hardware) the LED numbers are in 
irregular sequences.

Sw No The Switch number (if any) associated with the Idx.

Type Yes 
Initially this is the Type of display item. The values in the combo 
box depend on the Adder/Frame type.

Assignment Yes Dependent on the Type.

F1 Yes 
If the item is a switch (for example Bypass, Slide Switch), then this 
flag column can be set to ER (enable required) or none.

F2 Yes Not used.

F3 Yes Not used.

F4 Yes Not used

Tag 1 Yes 

Except for Common Controls, System Status and Man Ena, a 20 
character tag can be entered. It will be used to identify the control 
in messages, etc. For some Type/Assignment combinations the tag 
is generated and cannot be edited. 

Tag 2 Conditional 
Correlatable Switches (being analogous to Input Zones) accept a 
second line of 20 characters. 

Account ID Six digit decimal for the SIA report formats and four digit hexadecimal for 
Contact ID. 

Telephone Text Field for telephone number. 

Report Format Choose from SIA110, SIA300, Contact ID.

Table 12 Display Adder Info (Continued)

Name Visible Description
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5.9.2 Account 2 

5.9.3 Line 1 

5.9.4 Line 2 

5.9.5 Report Priority 

5.9.6 Timers

Account ID Six digit decimal for the SIA report formats and four digit hexadecimal for 
Contact ID. 

Telephone Text Field for telephone number.

Report Format Choose from SIA110, SIA300, Contact ID.

Dial Using Tone/Pulse.

Wait Check to wait for dial tone before dialling.

Dial Using Tone/Pulse.

Wait Check to wait for dial tone before dialling.

Alarm Choose one of the two accounts to use to report Alarms.

Supv Choose one of the two accounts to use to report Supervisory alerts.

Trouble Choose one of the two accounts to use to report Troubles.

AC loss delay 0-20 hours. Use this menu to delay the reporting of AC loss trouble on 
the dialer for the programmed time period.

Line 2 cellular 
test

To comply with UL 864 10th edition, leave this setting unchecked.

Use this menu to set the test report date for the cell phone setup. 
Uncheck this box if there is no test reporting for a cell phone, or if the 
phone line is a regular line. Set Day of month from 1 to 28 to schedule a 
test for Line 2 on a certain day of the month. See section 5.9.7 for more 
information.

When a cell phone service is employed for the panel, it should only be 
connected to telephone line #2 CO interface. Also, the dial tone detection 
feature of Line 2 should be disabled for cell phone application.

Auto test at Use this function to set the time for the automatic test. When this test is 
performed, the test report is sent to the monitoring station. To comply 
with UL 864 10th edition, this test must be performed at least once every 
6 hours.

The Auto test time can be configured to:

12:00 a.m. to 5:59 a.m.: test every 24 hours

6:00 a.m. to 11:59 a.m.: test every 6 hours

12:00 p.m. to 23:59 p.m.: test every 12 hours

If the Line 2 cellular test is disabled, then the test alternates between Line 
1 and Line 2. See section 5.9.7 for more information.
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5.9.7 Auto Test Time and Line 2 Cellular Test

If the Line 2 cellular test is disabled, then the dialer alternates between Lines 1 and 2 when 
performing the automatic test. If the Line 2 cellular test is enabled, then the automatic test is 
performed on Line 1 except on the day of the Line 2 cellular test, when it is performed on Line 
2. See examples in the following table.

5.9.8 Dialer

5.10 Common System Status

This list view appears in the top, right pane when the Common System Status item is selected 
in the Job Tree.

System Statuses are pseudo inputs that can be correlated to outputs. For example:

• Correlate a signal circuit to operate as a power supply. (using Init Done).

• Customize the Fire Drill operation.

• Correlate a relay to operate on Reset Command (using Sys Reset).

Line 2 cellular test Auto test at Line 1 Tested Line 2 Tested

Disabled 00:30
12:30 a.m. every other day 
(alternates with Line 2)

12:30 a.m. every other day 
(alternates with Line 1)

Disabled 6:00 6:00 a.m. and 6:00 p.m. 12:00 p.m. and 12:00 a.m.

Disabled 12:00 12:00 p.m. 12:00 a.m.

Day of month: 15 00:30
12:30 a.m. every day 
except on the 15th of the 
month

12:30 a.m. on the 15th of 
the month

Day of month: 15 6:00

6:00 a.m., 12:00 p.m., 6:00 
p.m., and 12:00 a.m. every 
day except on the 15th of 
the month

6:00 a.m., 12:00 p.m., 6:00 
p.m., and 12:00 a.m. on 
the 15th of the month

Day of month: 15 12:00
12:00 p.m. and 12:00 a.m. 
every day except on the 
15th of the month

12:00 p.m. and 12:00 a.m. 
on the 15th of the month

Line Retries Use this Spin Box to specify the number of retries to make (5-10).

Rings Use this Spin box to specify the number of rings when dialing in to 
configure. Warning: if set to zero the next dial in session will not be able 
to connect. 

Mode Choose between DACT and UDACT.

Enable Uncheck this box if you wish to set the dialer to the disabled state when 
you send the job to the panel. If you receive a job from the panel when 
the dialer was temporarily disabled then this check box will be un-
checked. The dialer is enabled by default. 

Aux 
disconnect 

If enabled, the dialer will block the alarm and supervisory events from 
being reported after the auxiliary disconnect button is pressed.
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5.11 Input / Output Circuit Summary

The Job Tree always contains an Input Summary and Output Summary item. Select either of 
these items to see a list of all of the circuits on the job.

This view of the Input Summary gives an Input UDACT reference number and tag required for 
programming by the Central Monitoring Station. On products that support them, this list may 
include Correlatable Switches. These will not have a value in the Loop and Address columns.

This view of Output Summary gives an output UDACT reference number and tag required for 
programming by the Central Monitoring Station.
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6.0 Add Items to the Job

6.1 Add Loop Controllers

To add an ALC-636 Dual Loop Adder

1. Right click anywhere in the Job Tree.

2. Click Add Loop Controller.

3. Loop 2 and Loop 3 will now appear in the Job Tree under Base I/O.

6.2 Add Annunciator

To add an annunciator

1. Right click anywhere in the Job Tree.

2. Click Add Annunciators.

3. In the Add Annunciator window enter the following information:

4. The dialog remains open for adding more Annunciators. Press Close to dismiss the 
dialog.

6.3 Add Correlations

Figure 29 Add Correlations Window

Select Type This control lists the types of Annunciator that can be added to the job.

The list will only shows the types that are allowed for your product type.

Number to 
add

Edit this number to add more than one Annunciator to the job.

Tag This field is enabled only if the panel product supports this feature. If 
enabled, enter a description for the Annunciator. If more than one 
Annunciator is added they will all receive the same tag. Tags can be 
edited in the Annunciator Information view.

Add Press Add to add Annunciator(s) of the selected type. The Job Tree will 
be updated to show the new Annunciator. If the limit for the job is 
exceeded an error message will be displayed.
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The Add Correlations window shows a tab for every category of circuit or display item, etc. 
that can be correlated to the items selected in the Details Pane of the GUI. The tab categories 
mirrors and synchronizes with those of the Correlations View. When a tab is selected on one 
the corresponding tab is activated on the other. 

The content of each tab is dynamically updated as correlations are added or deleted so that 
the window always shows the items that are available. 

To add correlations

1. From the Details Pane right click an item and select Add Correlations. The Add 
Correlations window appears.

2. Select the items to be correlated (hold down the Ctrl key and right click the mouse to 
select multiple rows) and click the Add button.

3. The window remains open and more correlations can be made, selecting items from 
other tabs if necessary. The dialog remains open when another target is selected in 
Configurator's Details Pane.

4. Click the Close button to close the window.

6.4 Add Device

Figure 30 Add Devices window
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To add devices

1. In the Job Tree select Loop1, Loop2 or Loop3.

2. From the Details Pane right click an item and select Add Device. The Add Devices 
window appears.

3. Enter the following information:

4. Click Add.

If there are not enough addresses, an error message appears.

• Click OK to cancel the procedure. The Configurator does not add any devices.

After the operation is complete, the window remains open for re-use. The Address value 
is adjusted to account for the devices just added.

If there are no available addresses for the chosen Type, then the Add button is disabled.

5. Click Close to close the window.

6.5 Add an AP Detector

When you add an AP detector, the default address is the lowest available address for AP 
devices. If there is an associated relay base or sounder base, the base has the same address 
with a B prefix. For example, a Photo Detector (AP) at address 1 has a sounder base at 
address B001.

Figure 31 Photo Detector (AP) device with the address 1

Type Major device type, with choices such as Photo Det, Ion Det, Supv 
Opt Mod, etc.

Options When you add some AP detectors (for example the Photo (AP)), you 
have the option to add a special base to the sensor head. The 
Configurator supports sounder bases and relay bases as 
alternatives to a standard base.

• To add a standard base, select NAB (Non-Addr. Base) from the 
Options menu.

• To add a sounder base, select ASB (Addr. Sounder Base) from 
the Options menu.

• To add a relay base, select ARB (Addr. Relay Base) from the 
Options menu.

For the Ten Monitor (AP) device, the options are Class A or Class B.

Process As Choose the type of alarm that you want to associate with this device.

Address Specify the address for the new device. This defaults to the lowest 
available address for the chosen type. It takes into consideration 
that some types require two or more addresses.

Number to Add Specify how many devices to add by changing the Number to add 
value. The Configurator attempts to allocate the devices 
sequentially, starting with the address you selected.
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6.6 Remove a Sounder Base from an AP Device

If AP devices are being used without sounder bases, you can remove the virtual device 
sounder base that was automatically added with the AP device.

Remove a sounder base

1. Select the sounder base in the Configurator.

2. Press Delete on the keyboard.

3. Click Yes to confirm.

4. Repeat these steps for every sounder base that you want to delete.

6.7 Add a Dual Sensor Device

When you add a dual sensor device (for example Dual Acclimate (AP), Fire-CO (AP), Photo-
CO Sel (AP), Dual Acclimate Sel (AP), Fire-CO Sel (AP)) a second virtual address is 
automatically created for the additional sensor. The virtual device has the same address as 
the primary sensor, but with a V prefix.

For example, a Fire-CO (AP) device with the address 1 has the following entries:

• Fire-CO (AP): 1

• Fire-CO “B” (AP): V001

• Sounder Base (AP) or Relay Base (AP) if selected: B001

Figure 32 A Fire-CO (AP) device with the address 1

6.8 Add a Dual Module Device

Some AP devices (for example Dual Mini Module (AP), Dual Monitor (AP)) have an additional 
input. When you add a dual input device to the Configurator, it is added as 1 real device and 1 
virtual device. The virtual device has the same address as the real device, but with a W prefix.

For example, a Dual Monitor (AP) device with the address 201 has the following entries:

• Dual Monitor (AP): 201 (primary input)

• Dual Monitor “B” (AP): W201 (secondary input)

Figure 33 A Dual Monitor (AP) device with the address 201

Note: If you remove a sounder base from an AP device, it cannot be restored. In order 
to restore the sounder base, you must delete the whole device and add it again.i
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6.9 Add a Multiple Module Device

Some AP devices (for example Six Relay (AP) and Ten Monitor (AP)) have multiple additional 
modules. When you add a multiple module device to the Configurator, it is added as 1 real 
device and a number of virtual devices. All the devices have the same number for their 
address, but the virtual devices have the prefix W and a numeric suffix after the address, 
starting at 1.

For example, a Six Relay (AP) device with the address 201 has the following entries:

• Six Relay (AP): 201 (primary relay)

• Six Relay “B” (AP): W2011 (second relay)

• Six Relay “B” (AP): W2012 (third relay)

• Six Relay “B” (AP): W2013 (fourth relay)

• Six Relay “B” (AP): W2014 (fifth relay)

• Six Relay “B” (AP): W2015 (sixth relay)

Figure 34 A Six Relay (AP) device with the address 201

6.10 Add Display Adder

Figure 35 Add Display Adder window

To add a display adder

1. In the Job Tree select one of the listed annunciators and right click an item and select 
Add Display Adder. The Add Display Adder window appears.

2. From the drop down menu select the desired Display Adder.

3. Click Add and the Display Adder will be added to the Job Details under the selected 
Annunciator.
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6.11 Add IPS 2424DS and IPS-4848DS

Add an IPS-2424DS

1. Select the annunciator or display adder that you want to add the IPS-4848 to.

2. Click Insert in the menu bar, then click Add Display Adder.

3. Select 24 Sw Adder New in the Select Adder Type pulldown menu.

4. Click Add.

Add an IPS-4848DS

1. Select the annunciator or display adder that you want to add the IPS-4848 to.

2. Click Insert in the menu bar, then click Add Display Adder.

3. Select 48 Sw Adder in the Select Adder Type pulldown menu.

4. Click Add.

6.12 Configure IPS 2424DS and IPS-4848DS to Operate a Bypass 
Group

Create a bypass switch

1. Select the 24 Sw Adder or 48 Sw Adder.

By default, all the switches are unassigned.

2. Double-click <unassigned> in the Type column for a switch, and select Byp Zone.

In Figure 36, switch 0 on the 24 Sw Adder is a bypass switch.

Figure 36 Bypass switch

Create a bypass group

1. Select Bypass Group under Base I/O.

2. Click Insert in the menu bar, then click Add Group.

A new bypass group appears with the name New Grp.

Figure 37 New bypass group
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3. Double-click the name of the new group and type a descriptive name.

4. Right-click the bypass group, then click Add Correlations.

The Select items to add window appears.

Figure 38 Select items to add to bypass group

5. Select the devices that you want to add. To select more than one device, hold down the 
Ctrl key and click the devices.

6. Click Add.

7. In the Select items to add window, click the Display tab and select the adder switch to 
assign to this bypass group, then click Add.

Figure 39 shows the bypass switch created in "Create a bypass switch" on page 47.

Figure 39 Add switch to bypass group

8. Click Close.
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6.13 Delete Correlations

If you change a Device Type, you might see the following message. This can happen after you 
have performed an Auto Configuration on the panel.

Figure 40 Change process type warning

To delete a correlation

1. Click the correlation, and then click the Edit menu and click Delete Item.

2. Click Yes to delete the correlation.

Hold down the Shift key to select more than one correlation at once.

6.14 Hazard Zones

Hazard zones can be added to FX-3500RCU panels. To determine if you have an FX-
3500RCU, go up to your panel, press Manual (M), and then press Information (?). If the letters 
RCU are displayed at the end of the first line, your panel is an FX-3500RCU.

Hazard zones are configurable by correlating input devices, releasing circuits, (pre)release 
signals, and manual release and abort switches. For more information on Releasing 
Operation, see LT-1091 FX-3500RCU Releasing Application Guide on 
http://www.mircom.com/.

Note: If you want to change the Device Type of a circuit that is correlated with a hazard 
zone, you must delete the hazard zone from the correlations first.

Note: If you send a job with hazard zones to an FX-3500, the MGC-3000 configuration 
software will display an error message telling you that the panel is the wrong 
model and that the job can only be sent to an FX-3500RCU panel.

Notes:   Abort switches are only configurable in Preaction/Agent release applications.

Soak Delay timer is only configurable for Deluge applications.

i

i

i
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6.14.1 Counting Zone Type

Releasing applications must be configured with one of the following Counting Zone types:

6.14.2 Abort Type

Releasing applications must be configured with one of the following Delay Timer types:

6.14.3 Configurable Timers

Releasing applications may be configured with the following timers:

Single Activation of any one input device correlated to the hazard zone will initiate 
the release process.

Double Activation of any two input devices correlated to the hazard zone will confirm 
the alarm and initiate the release process.

Triple Activation of any three input devices correlated to the hazard zone will 
initiate the release process.

2 Input Types Activation of any two different input device types (ion, photo, heat etc.) 
correlated to the hazard zone will initiate the release process.

ULI Press Abort and the timer continues to count down and stops and holds at 10 seconds. 
Release the ABORT switch and the timer resumes the countdown at 10 seconds.

IRI Same as ULI with the following condition: For the Abort switch to function, you must press 
and hold the Abort switch before the second zone goes into alarm.

NYC Pressing the Abort switch causes the control panel to add 90 seconds to the Release 
Delay Timer (RDT). 

Pressing and holding the Abort switch stops the Release Delay Timer (RDT) from 
counting down. Releasing the Abort switch resumes the count down of the RDT.

AHJ The timer does not start while you press and hold the Abort switch. Press the Abort switch 
and the timer resumes counting down. Press the Abort switch again to restore the timer to 
its full value. Release the Abort switch and the timer resumes counting down.

Release Delay Timer
(RDT)

The amount of time from when the Hazard Zone is activated 
via correlated input devices until release. 

The maximum value for the RDT is 60 seconds.

Soak Delay Timer
(SDT)

The amount of time that the releasing circuit will be active. 
Upon the expiration of Soak Timer, the releasing circuits will 
be shut off. Only configurable in Deluge applications.

The maximum value for the SDT is 600 seconds.

Configuring the SDT to 0 seconds causes the releasing 
circuits to shut off ONLY when the system is reset. 

Manual Release Delay Timer
(MRDT)

The amount of time from when the Manual Release Switch is 
pressed until release.

The maximum value for the MRDT is 60 seconds.
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To add a hazard zone

1. From the Job Tree select Hazard Zone.

2. Right click in the Details Pane and select Add Zone. A zone will now be added to the 
Details Pane.

3. Enter the following Information

Attention: Manual Release cannot be aborted once it has been initiated.

Zone Label Name of the Zone.

Type Pre-Action/Agent or Deluge.

Counting Zone Type Single, Double, Triple, 2 Input Type.

Abort Type ULI, IRI, NYC, AHJ.

Rel Delay The maximum value for the RDT is 60 seconds.

Soak Delay The maximum value for the SDT is 600 seconds.

Man Release Delay The maximum value for the MRDT is 60 seconds.

Manual Release Priority To ensure a Manual Release Switch overrides an 
Abort Switch, in the MGC-3000 configuration 
software set the Man Rel Priority flag for the Hazard 
Zone zone to Yes.

!
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7.0 Manage the Database
The database stores all jobs and their information. Databases can be Backed Up, Restored or 
Compacted.

7.1 Backup Database

Backup database makes a copy of the Master Database.

Figure 41 Backup Database

To back up the database

1. Click File > Backup Database. The file location specified in the User Preference 
appears and the file name will be in the form of YYYY-MM-DD.mdb.

2. Click Save. A popup window appears notifying you of a successful backup.

The backup can be used by the Restore Database command to recover all of the jobs in the 
database. You can also use the Import command to recover selected jobs from a backup. 
Backup your Master Database often and store a copy of the resulting file on a CD or other 
media.

Note: If the Keep Only Latest Versions After Backup option of User Preferences is 
enabled, old versions of each job in your main database will be deleted, retaining 
only the latest version of each job.i
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7.2 Restore Database

Restore database reads a database file and imports every job found there, after first deleting 
all of the jobs in the current database. The backup database could have been produced by an 
older version of the configuration tool, in which case all necessary conversion is performed. 
Conversion is sometimes necessary when a new version of the configuration tool is released. 
The install program will make a backup and instruct you to run Restore Database to convert all 
of your jobs.

Figure 42 Restore Database

To restore a database

1. Click File > Restore Database and a warning appears.

Figure 43 Restore Database

Warning: When you restore from an older backup you will lose any changes that 
have been made since the time of the backup.!
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2. Click Yes to continue.

3. The file location specified in the User Preference appears and the file name will be in the 
form of YYYY-MM-DD.mdb.

4. Select the desired database and click Open. A popup window appears notifying you of a 
successful restoral.

7.3 Compact Database

A database that has been the subject of many deletions and additions can become 
fragmented and occupy more space than required. Compact Database executes a standard 
MS-Access utility to recover the space and improve performance.

To compact a database

1. Click File > Compact Database. A status window will appear. There will be no further 
notification.

Note: This may take several minutes for a large database.i
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8.0 Manage Jobs

8.1 Create a New Job

Figure 44 Create Job window

To create a new job

1. Click Job > New Job and the Create Job WIndow appears.

2. Enter the Following information:

3. Click OK. The Job will now be created and the corresponding information will be 
reflected in the Details Pane.

Enter a description for new 
job

This name, which should be unique, will identify the 
job throughout its lifetime. Note that in a multi-
product environment the same job name cannot be 
used for jobs of different products, even if you don't 
currently have access to all possible products. An 
error message is displayed if the name is not unique. 
The error message will help you identify duplicates 
that belong to other products or brands.

Author The technician who is creating the new job. The 
default is automatically inserted but can be 
overridden.

Comments (Must be entered) Enter a comment. It can span multiple lines. This will 
become part of the job's version history.

Model Choose the Panel Model for your new job that best 
matches the Agency, Description and Language 
fields.

Copy current job data As an alternative to choosing a standard template, 
check this box to make a copy of the current job 
(which is presently open in the Configurator). In this 
case the Panel Model and Job Template controls are 
disabled.
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8.2 Open Job

Figure 45 Select Job and Version window

Open Job allows the user to select a job and job-version in the database and open it in the 
user interface. The Select Job list view shows all of the jobs on the database. By clicking on 
the column heading you can sort the jobs by:

• Job Number

• Job Description

• Product (where more than one product is supported)

The Select Version list view shows all of the versions of the selected job. This includes the 
date and a description.

To open a job

1. Click Job > Open Job and the Select Job and Version window appears.

2. Select the desired Job and click OK. The Job will now be opened.

8.3 Import Job

Figure 46 Import Job window
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This command imports a selected job/version from an external database or serialized job 
archive as created by the export or Backup Database commands. and converts the job to the 
current version if necessary. The user chooses the type (MDB or Serialized Archive) and 
location of the file to read. The location defaults to the Job File folder specified in User 
Preferences.

If the selected type is MDB, then the Microsoft Access database (usually a database that 
resulted from a Backup Database) is opened. A list view, similar to the Open Job dialog, 
displays jobs contained in the database. The list will be restricted to the Products for which the 
user is authorized. 

The chosen job is read and copied to the current database using logic common to Restore 
Database. If the version of the source database is not too old (no forward conversion is 
possible) and is not younger than the current database, then any necessary conversion is 
performed. If the database version is not compatible, an error is displayed. 

If the selected type is fx2job (a serialized archive, usually the result of Export) then the Jobs 
found in the archive's index are listed. The data structures are de-serialized and treated very 
much as if they had been downloaded from a panel. The program adjusts older versions of 
data structures to the current standard, extracts the data and stores the job on the database. 

If the same job (identified by its name) is already on the database, then the next highest 
version is assigned to the job. 

If a job with the same name is not on the database, then a new job is created. 

To import a job

1. Click Job > Import Job and the Select file to import window appears.

2. Select the desired Job and click OK. The Job will now be opened.

8.4 Export Job

Figure 47 Export Job window

Export is used to exchange a single job, for example between technicians. The fx2job format 
results in a very small file, suitable for electronic transmission.

By default, the file is given a name “Jobnn-vv” where nn is the job number and vv is the 
version. You can change the name to make it easier to identify the job.
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To export a job

1. Click Job > Export Job and the Export Job window appears.

2. Select the file type to export:

3. Click Save and the job will be exported.

8.5 New Version

To create a new job version

1. Click Job > New Version. The New Job Version window appears.

2. Enter who is making the change, any related comments and click OK. The version will 
now be saved.

8.6 Delete Job Version

Deleting the Job Version deletes the currently open Job from the Database. It will no longer be 
accessible form the Version History window.

To delete the currently open job version

1. Click Job > Delete Version. A window asking if you want to permanent delete the 
current version appears.

2. Click OK. The job version is now deleted.

8.7 Version History

Figure 48 Version History window

.mdb A Microsoft Access database containing a single job is produced.

.fx2Job A compact archive file is produced.

OpenGN

OpenGN 
Phase II

Select this file type to produce an XML file to import into OpenGN.
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The version history of the current job is displayed in list form, beginning with the most recent 
version.

To open the Version History Window

1. Click Job > Version History. The version history window appears.

2. Click OK to close the window and return to the main GUI.

8.8 Compare Job Versions

For an in depth explanation on Comparing Jobs and Differences mode see section 12.0 on 
page 77.

Figure 49 Select Job to Compare window

Number The version number. Each time a new version is created, either with the New 
Version command or by getting a job from the panel or an archive, a new 
version number is allocated.

Date The date and time the version was created.

Changed by The user who created the version.

Description The description, as entered when the new job version was created.

Type Uploaded: the new job version was a result of a Get Job.

New Job: the user created a new version manually.

Status Locked: the job has been sent to the panel and is locked against editing.

Editable: the job is editable.
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To compare jobs

1. Click Job > Compare Jobs. The Job to Compare window appears.

2. Select the Secondary Job, Version, if you would like to show identical Items and any 
Advanced Options. For more information see section 8.8.1 on page 61.

3. Click OK and you will Enter Differences Mode.

Primary Job This field reminds you which job you have already established as 
primary job: the base job against which the secondary job will be 
compared.

Select Secondary Job: 
Select Version

Use the combination of Job and Version to select the secondary 
job. The job defaults to the same one you established as Primary. 
Normally you will only need to choose a newer version of the 
same job. You are prevented from choosing the same Job and 
Version for Primary and Secondary.

Just as when establishing the primary job, you can sort the list of 
secondary jobs by Job Number, Description or Product.

Show Identical Items Check this box if you want to see not only changes, but also those 
items that stayed the same. Normally you will leave this un-
checked. Differences are easier to see and Print generates less 
output if identical items are not included. 

Advanced Options When you press this button the Advanced Options dialog is 
launched. Here you can change some of the more advanced 
filtering options. They are normally all checked by default and in 
most situations do not need to be changed.

See section 8.8.1 on page 61.
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8.8.1 Advanced Compare Options

Figure 50 Advanced Compare Options window

Modified Check this box to include any item that has been modified. (Modified means 
that it is the same adder, circuit, switch, etc. but some attribute has been 
changed.) This box is checked by default. You would only un-check this box if 
you did not want to see items that have been modified. 

Present only in 
Secondary Job

Check this box to include items that are only present in the secondary job. This 
means that Loop Adders, Annunciators, Display Adders, circuits, etc. that were 
not on the base job will be included. This box is checked by default. You would 
only un-check this box if you did not want to have new additions reported.

Present only in 
Primary Job

Check this box to include items that were only present in the primary job. This 
means that Loop Adders, Annunciators, Display Adders, circuits, etc. that were 
removed from the primary job will be included. This box is checked by default. 
You would only un-check this box if you did not want to have deletions reported.

Advanced 
Options

When you press this button the Advanced Options dialog is launched. Here you 
can change some of the more advanced filtering options. They are normally all 
checked by default and in most situations do not need to be changed.

Notes:   Filtering of 'Present only in Secondary' and 'Present only in Primary' do not apply 
when presenting the tree. The tree is shown in its entirety, regardless of these 
settings. The filtering is only applied to the Device, Display Item and similar lists. 
It is intended to make it easy to see what components have been physically 
added or removed from the job.

Correlations are not considered to be items in this context. If a correlation was 
added, then that is effectively a modification to the item that received the 
correlation.

If you chose to check Present only in Secondary Job and/or Present only in 
Primary Job, but you do not check Modified, then the circuits, etc. that have only 
had correlation changes will not be included.

i
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8.9 Validate Job

To validate a job

1. Click Job > Validate Job.

2. If there are no errors with the job there will be no further notifications. If there are errors 
with the job a window will appear advising as to what the errors are.

8.10 Edit Job

This command toggles the edit lock on a job.

A newly created job or a new version of an existing job can be edited immediately.

An existing job, freshly opened, can be locked at two levels. A job that has never been loaded 
to a panel is locked against accidental change. The locking of such a job can be simply 
toggled by using the Edit Job menu option. If a job is locked and the user enters keystrokes on 
any of the editable forms or lists, a dialog will be shown, asking the you to confirm your intent 
to edit the job.

If you answer Yes, the job is unlocked (as if the menu option had been selected). The GUI’s list 
and forms then allow editing, with changes taking immediate effect. If you answer No, all 
subsequent keystrokes (or mouse clicks) on that form or list are ignored. 

Figure 51 The job is protected against unintentional edits

A job that has been loaded to the panel has a harder level of locking. It is intended to prevent 
the database and panel copies of the job diverging. If the user attempts to toggle the lock from 
on to off, then the following message appears. 

Figure 52 This job version has already been built or downloaded to the panel

If you choose to proceed, the job is unlocked. If an attempt is made to edit the same job on 
one of its lists or forms, a similar dialog is shown but without the option to unlock the job.

Once a hard locked job has been unlocked, it can only be toggled between soft locked and 
unlocked.
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9.0 Work with the Panel

9.1 Connect

Figure 53 Connection window

To connect to the panel

1. Select a connection type:

2. Click Connect. Once a connection has connected you might see a window saying that 
the panel time and the PC do not match. Click Yes and the update Panel time window 
appears.

3. Set the time and click OK. 

4. You will be informed that the time has been updated. Click OK.

Direct Serial Select this option if you have connected a serial cable directly 
from the serial port (or USB / UIMIA) of your computer to the fire 
alarm panel.

Modem Select this option if the fire alarm panel is capable of being 
programmed remotely. The combo-box will list the modem(s) 
found on your computer.

Telephone Number Enter the phone number to which the fire alarm panel is 
connected. The text field will show the last number you entered.
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9.2 Send Job

To send a job to the panel

1. Click Panel > Send Job. A confirmation window will appear.

2. Click Yes. Once the job has been successfully sent a confirmation window will appear. 
Click OK.

9.3 Get Job

To get a job from the panel

1. Click Panel > Get Job. The create job window will appear.

2. Enter the Job information and click OK. Once the job has been retrieved a confirmation 
window will appear. Click OK.

9.4 Panel Information

This dialog displays a summary of panel and the Configurator information, with options to view 
more detail. The information includes:

• The Product Version

• Name and Version of the job currently loaded on the panel

• Model (deduced from Product, System (build) Type and Hardware Features)

• The Date it was sent

• The ESD and Tech who sent / owns the job. (For products secured with a key)

• Security Key SIN. (For products secured with a key)

• FXConfig Version

• Date and Time Last Changed

• Number of times auto configured

• The Panel Time

An Advanced button launches Advanced Panel Info which retrieves and displays the Type, 
Product Version, Language, on line status, etc. of all Nodes and their CPUS.

An Update button allows the panel time to be corrected/updated from the Configurator for 
those products that support the feature.

9.4.1 Advanced Panel Information

Polls all the nodes on the panel and checks their status against the configuration. This 
information may not appear for all annunciators.

The following information is displayed:

• Node - address

• Type - CPU Type

• Version - current firmware version (n/a for RA1000)

• Language - language in firmware (standard messages/menu etc.)
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• System Type - one of the following 

• Compact Build 

• Large Build 

• HW Type - "base" or "Exp. Master" for the Large board 

• HW Vers - currently always VX.X.X

• Status - one of the following:

• Online 

• Not responding 

• Wrong type (configured as "xxxx" ) 

• Unconfigured CPU 

• Firmware version mismatch

• Address mismatch (configured as node xx)

• Offline trouble: xxx xxx 

9.5 Event Log

The Event Log dialog has 2 tabs, one for the General log and one for the Alarm log. The 
operations of each tab are identical. When the dialog is displayed, events of the currently 
active tab will be read from the panel automatically in the background and start filling the list 
with event data. 

A simple status field is shown at the bottom to indicate the progress of reading the events. 
Events are shown on a list with the columns: No., Date and Time and Event Description. Scroll 
the list up or down to see more events. 

You may stop the background read process by clicking the Stop button at any time. To re-read 
the list, click the Refresh button. The list of the active tab will be cleared and the background 
read will be initiated again. It is not necessary to press the Refresh button just to read any new 
events because they will be added to the top of the list automatically if the background read is 
not stopped. 

Clicking the Export button will let you export the list of the active tab to a CSV file. The CSV file 
could be imported to common spreadsheet software such as MS Excel for further analysis. 
Click Close to close the dialog. 
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9.6 Upgrade Firmware through the Micro-USB Port on the Core 
Board

You need the following items in order to upgrade the firmware on the FX-3500/3500RCU.

• Windows 10 computer with a USB port.

• USB A male to micro-B male cable.

• MGC-3000 Series Configuration Utility (the Configurator).

• A copy of the firmware.

Upgrade the firmware

1. Connect the USB cable to a USB port on the computer, and to the USB port on the FX-
3500/3500RCU plug-in core board. This port is labeled P5.

Figure 54 Micro-USB port on the core board

Attention: Follow the instructions in this section only if the panel’s plug-in core 
board has a sticker showing “SO-289 v3.0.1” (or a number higher than 
3.0.1).

If the panel’s plug-in core board does NOT have a sticker showing 
“SO-289 v3.0.1” (or a number higher than 3.0.1), follow the instruction in 
section 9.7 on page 70.

!

JW4 JW5
Core Board

Micro-B USB Port
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2. In the MGC-3000 Configurator, click File > User Preferences.

3. In the Serial Port menu, select the COM port that the USB cable is using.

Figure 55 Select the COM port in User Preferences

4. Click OK to close the User Preferences window.

5. Click Panel > Upgrade Firmware.

The Upgrade Firmware Wizard appears:

Figure 56 Upgrade Firmware Wizard

6. Click Browse and select the firmware file.

7. Click Next.

8. Follow the instructions in the next window:

a. Disconnect AC power and batteries in order to fully remove power from the panel.

b. Disconnect the micro-USB cable from the plug-in core board.

c. Remove the jumper from JW4 on the plug-in core board and place it on JW5.
67



d. Reconnect the micro-USB cable to the plug-in core board.

Figure 57 Upgrade Firmware Wizard

9. Click Next.

A window appears showing the firmware upgrade status.

Figure 58 Upgrade Firmware Wizard: Sending file
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10. After the file is sent successfully, click Next.

Figure 59 Upgrade Firmware Wizard: The panel is upgraded successfully

11. On the next window, click Finish.

Figure 60 Upgrade Firmware Wizard: Click Finish to complete the process

12. Disconnect the micro-USB cable.

13. Remove the jumper from JW5 and place it on JW4.

14. Restore power to the panel.

Note: During normal operation, the JW4 jumper is closed and the JW5 jumper is open.i
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9.7 Upgrade Firmware through the Main Board

You need the following items in order to upgrade the firmware on the FX-3500/3500RCU by 
connecting to the main board:

• Windows 7 or Windows 10 computer with a serial or USB port

• MGC-3000 Series Configuration Utility (the Configurator).

• A copy of the firmware.

• MGC-CONFIG-KIT4 Fire Panel Configuration Kit (this kit includes the cables required to 
connect the computer to the Fire Alarm Control Panel)

1. Connect the laptop to the panel using one of the methods shown in section 1.4.1 on 
page 13.

2. In the MGC-3000 Configurator, click File - User Preferences.

3. In the Serial Port menu, select the COM port that the cable is using.

Figure 61 Select the COM port in User Preferences

4. Click OK to close the User Preferences window.

5. Click Panel > Upgrade Firmware.

Attention: Follow the instructions in this section only if the panel’s plug-in core 
board does NOT have a sticker showing “SO-289 v3.0.1” (or a number 
higher than 3.0.1).

If the panel’s plug-in core board DOES have a sticker showing “SO-289 
v3.0.1” (or a number higher than 3.0.1), follow the instructions in 
section 9.6 on page 66 above.

!
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6. The Upgrade Firmware Wizard appears.

Figure 62 Firmware Upgrade Wizard

7. Click Next.

8. Follow the instructions on the screen to upgrade the firmware.

Figure 63 Jumpers on the two kinds of core boards

Note: The instructions in the Upgrade Firmware Wizard include moving the 
jumpers on the core board. The jumpers on the old green core board and 
the new red core board are in different positions as shown below.!

Green core boardNew red core board

JW4

JW5
��� ���

���	
������
	�
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10.0 Tools Menu

10.1 Extract All DB

This command extracts every job on the database and produces an individual database file for 
each. It has the same effect as running Export Job for every job. Unlike Export Job, you do not 
have the choice of making a compact serial archive (FX2Job).

10.2 Validate All

This command will validate the latest version of every job on the database. It also produces a 
C file for each job and stores it in the Job Build folder.

It has the same effect as using Validate Job on each job. Before the process starts, it displays 
the Build Job dialog so that you can specify the version of the product to be built.

10.3 Build Job

This command validates and builds the current job, producing a C file in the Job Build folder. 

It performs the build assuming the latest product version. 

10.4 Build Job Old Versions

This command validates and builds the current job, producing a C file in the Job Build folder. 

It first shows the Build dialog so that you can choose the product version. You can use this 
command to produce the C files for older versions of the panel. 

10.5 Link Statistics

This command displays statistics for the connection between the Configurator and the fire 
alarm panel.

10.6 Log Send

Toggle the current state of the "dump on send" option. Causes the ".c" file to be produced and 
dumped on a Get Job.

10.7 Log Get

Toggle the current state of the "dump on get" option. Causes the ".c" file to be produced and 
dumped on a Send Get.

10.8 Log Comms

Toggles logging of serial communications.
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10.9 Trace

Toggles the current state of the trace option. When turned on this causes debug information to 
be written to a trace file

10.10 Display Structure

This utility allows you to view the contents of a panel data structure. You have the option of 
continually retrieving and displaying the same structure at a refresh rate you specify. You can 
also log the results to a file. 

To display a structure

1. Connect to the panel and click Display Structure under the Tools menu (you must have 
selected Show Tools Menu under preferences). The following dialog appears. 

2. Choose the CPU. 

3. Choose the Structure on that CPU. Loop structures are qualified with a loop number. e.g. 
gLCUPollData - Loop 2. 

4. Choose the entry (for Poll Data there is one entry per device, other structures may be 
organized differently. 

5. Choose how many entries to display. The maximum is adjusted automatically to 
compensate for the selected start entry. Note: The actual entries on the panel may be 
less than the maximum. If you choose a start entry higher than the actual number of 
entries on the panel you will get an error message. If you choose a number of entries 
greater than those actually on the panel, you will receive only those that are present.

6. You can get a "one shot" display by pressing Refresh.

7. To run continuously, select a refresh rate and press Start.

8. To log to file check the Log To File box and specify a destination file.

9. You can adjust the refresh rate, the start entry and the number of entries while the 
display is running. They will take effect after the next interval has expired.

10. To view a different structure you must first press stop.

10.11 External Bus

Toggles the "Use External Bus" setting. When turned on, this signals that the Configurator is 
connected to the External Bus of the panel.

10.12 About MGC-3000 Series Configuration Utility

Displays the copyright notice and version number of your copy of the Configuration Utility.
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10.13 Paste Special - Circuits, Adders or Entire Loops

This dialog appears in response to a Paste Special when pasting circuits, conventional adders 
or entire loops.

Figure 64 Paste Special

The text summarizes what is being pasted and its destination.

e.g Copying Node 1, or Pasting 3 devices to loop 2.

10.14 Paste Special - Display Items, Display Adders or Annunciators

This dialog appears in response to a Paste Special when pasting display items, display adders 
or entire annunciators.

Figure 65 Paste Special

Number of copies specifies the number of copies to make. The paste operation will 
attempt to make the specified number of copies. If the capacity of 
the destination is exceeded a message will be displayed to inform 
the user how many were successfully made. 

Copy I/O correlations If this box is checked the copied device(s) will have the same I/O 
correlations as the original.

Copy display correlations If this box is checked the copied device(s) will have the same 
display correlations as the original. 

Retain Address Check this box to retain the same addresses on the copied 
devices. A message will inform the user if this is not possible. 
Retain Address can fail if the destination loop controller does not 
have sufficient free addresses. Retain Address will always fail if 
the source and destination are the same loop. 
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The text summarizes what is being pasted and its destination.

e.g Copying Node 33, or Pasting 3 display items to frame 0.

A regular copy is defined as follows.

The LEDs and/or switches are copied using newly assigned LED Grps. 

Common Control Status LEDS are an exception - all similar types share the same Grp. e.g. A 
copied and pasted Signal Silence would retain the LED Grp of the source. 

All attributes (tags, flags, etc.) are replicated. 

If IO Corrs is checked, then these too are assigned to the new copy. This is a "deep" copy. 

If IO Corrs is not checked, then of course they are not copied. This is the "shallow" copy. 

A Reference copy is defined as follows.

New LEDs and switches are defined, but they retain the LED Grp of the source. 

If any 3 POSITION SLIDE SWITCH is encountered while attempting a "Reference Copy" of 
individual items, a complete adder or an entire annunciator, an error message is displayed and 
a roll back of the operation occurs. 

Both the new copy and the source (and any subsequent reference copies) will be marked with 
an asterisk to warn the user that the items are 'linked" or cross referenced. A change to one 
(e.g. addition of CORRS) affects the others. 

Number of copies specifies the number of copies to make. The paste operation will 
attempt to make the specified number of copies. If the capacity of 
the destination is exceeded a message will be displayed to inform 
the user how many were successfully made. 

Make New Copy Choose this option to make an unrelated replica of the source. 

Copy I/O Correlations If this option is checked, the new display item(s) will be correlated 
to the same circuits and devices as the source. 

Make Reference Copy Choose this option to make a reference copy of the source. 
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11.0 Correlations Pane
Most of the primary list views (shown in the top right pane) are used in combination with a 
correlation view in the bottom right pane. The correlation view is a tabbed pane. Each tab 
shows a different category of circuit, display LED, etc. 

Figure 66 Correlations Pane

11.1 Input Circuit Correlations

If the currently selected circuit(s) is/are inputs then the correlation view has tabs for: 

• Signals 

• Relays 

• Display Points (Input Zone and Bypass, etc.) 

11.2 Output Circuit Correlations

If the currently selected circuit(s) is/are outputs then the correlation view has tabs for: 

• Alarm 

• Supv 

• Trouble 

• Monitor 

• Display Points (Output Zones and Bypass LEDs etc.).

When the user selects Add Correlations a non-modal dialog is used to display the circuits and 
display items that are eligible to be correlated to the selected items in the top, right pane. It has 
the same set of tabs as the correlation view. It is kept synchronized with the correlation view: if 
a certain tab category is selected on one, its counterpart is automatically selected on the other. 
As correlations are added to the current set, they are removed from the available set. 

If multiple items are selected in the top pane, then the correlations view will only show those 
correlations that are common to all of them. This means the set of displayed correlations can 
shrink to the empty set. If the user selects a mix of input and outputs no correlations can be 
shown.
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12.0 Differences Mode and Differences 
Report

12.1 Introduction

The Configurator has the capability of comparing two jobs. Once differences mode is entered 
the job tree shows which elements have been added, removed or changed. The list views 
show in more detail which items have been modified or whether correlations have been added 
or removed. 

In differences mode a report can be printed. The scope and depth of the print report can be 
chosen, similar to when printing a single job.

The differences report is intended primarily to provide the authorities with a detailed list of what 
has (and what has not) been changed. Such a report can used to justify only minor re-testing 
of an installation.

12.2 Primary vs. Secondary Job

In this document we will refer to Primary and Secondary jobs. The primary is normally the 
older job, currently in service. It is the base against which the secondary job - the newer, 
modified job - is to be compared. 

You will normally first establish the primary job by opening it using the Job Menu and choosing 
the desired Job and Version. Then you will invoke differences mode, where the secondary job 
is chosen.

This document occasionally refers to items that have been added or deleted. These terms are 
used with respect to the primary - assuming that the primary is the older job. There is nothing 
to prevent you from reversing this convention and establishing a newer job as the primary.

12.3 Initiating Differences Mode

Differences mode can be initiated either by selecting Compare Job Version from the Job 
Menu, or by clicking the Differences icon in the tool bar.

When you initiate Job Compare, the Job Compare Dialog is displayed.

Press OK to enter differences mode. This can take several minutes, as the program examines 
every component of each job and decides if it is added, removed or changed. Correlations are 
also compared during this phase. A changed correlation is reflected not only in the correlations 
list, but is propagated (as a modification) up to the device or circuit list and from there to the 
Device Loop in the job tree. A dialog is displayed to inform the user of the progress of 
difference reporting and to allow the action to be canceled. If you cancel, the display reverts to 
the primary job, in normal mode.

12.3.1 Interpreting the results

When the comparisons have all been made, the jobs are presented as one job tree. See 
below.
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Figure 67 Differences

The magnifying glass icon represents an item that has been modified, symbolizing that it 
warrants a closer look: some lower level attributes have changed.

Items that have not changed are given the green check mark icon. More precisely, this means 
that there were no reportable changes on this item or any of its lower levels. If you chose a 
non-standard set of options and excluded, for example '..items that are modified', then a green 
check mark will appear if there are modifications, but no deletions and additions. This is 
because you chose to ignore or exclude them. This icon is only used in the job tree. Items in 
list views are suppressed completely if you choose not to include items that are identical. If 
you include items that are identical, then they have no icon at all. This is to avoid clutter and 
aid readability of the lists.

Notice that the Main Display itself did not change. None of its attributes were changed. The 
fact that some changes were made to its Base Control/annun. does not cause the Main 
Display itself to be marked as changed.

An item that has been removed (is present on the primary job, but not present on the 
secondary) is depicted with this symbol.

And, conversely, items that have been added are identified with this symbol.

Where a minor modification to a form, a device, LED or switch has been made, two adjacent 
rows are presented. The attributes that remained the same are represented by ditto marks in 
the second row.

Where the only difference between two list items is in its correlations, the magnifying glass 
symbol is used. Again, this means that the user can click on it to view the actual changes: in 
this case, the correlations in the bottom, right pane.
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13.0 Printing
The print and print preview operations function just as in regular mode. You can choose to 
print the differences of the entire job, a single node, or a node and its sub-nodes. In addition to 
choosing how much of the job to print, you can also decide whether to print Outputs with Input 
Correlations, Inputs with Output Correlations or Display Correlations.

If you chose to suppress identical items when you entered differences mode, then any node in 
the tree that is marked with a green check mark will not be printed. Items whose only 
difference is in the lower level correlations are also not printed: only the actual correlations. On 
the printout the symbols - - > and < - - are used in place of the added and removed icons. The 
same symbols are used on pairs of lines to indicate which one is from the primary ( < -- ) and 
secondary ( - - > ).

If the print range of the job was Complete Job, then you may decide to choose only one of 
Input or Output Correlations, since every input has a corresponding output somewhere on the 
job. Be aware that if the print range does not encompass the complete job, then selecting only 
Input or Output may not include all correlations. 

The Input and Output summaries will list any changes to the UDACT numbers to be reported 
to the authorities.

TIP: Print Preview works best if you maximize the Preview window (other windows can't cover 
part of it, requiring a redraw when moved) and zoom in/out so that a complete out put page fits 
in the window (you don't have to scroll to view other parts of a page, which would cause 
frequent redrawing). 

When you initiate either Print or Print preview, the following dialog is displayed 

Figure 68 Print
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Print Range You can specify the range or scope of the print job using these 
controls.

Complete Job Regardless of what item in the Job Tree you currently have 
selected, the complete job will be printed. The print program will 
print all of the details of the Base Panel, followed by all of its loops, 
main display, etc. Then it will progress to the next major node of 
the tree (e.g Loop Adder, CPU 1), printing its details and all of its 
contained loops. This process continues in a depth first manner, 
until the entire job has been traversed and printed. Each node of 
the tree is started on a new page.

Current Node If you choose this option, the print job is restricted to details of the 
tree node or job component that you currently have selected in the 
Job Tree. No details of contained loops, etc. are printed.

Current Node and 
Subnodes

this option prints details of the currently selected tree node and all 
of its sub-items (and those items' sub-items, if any).

Outputs with Input Corrs If this box is checked, then the Inputs correlated to Output circuits 
are printed in addition to the regular print. This is done for any 
relevant tree nodes / loops that are included in the scope of the 
print job.

Inputs with Output Corrs If this check box is checked, then the Outputs correlated to Input 
circuits are printed. Status correlations are included with this 
option. This is done for any tree nodes / loops that are included in 
the scope of the print job.

Display Corrs If this check box is checked, then the Display correlations are 
printed. This is done for any relevant tree nodes / loops that are 
included in the scope of the print job.

General Note - Correlations If a tree node has no correlations, then it is skipped entirely by the 
print program. If a tree node has correlations, then a header is 
printed for every "correlated from" device. Beneath it, and tabbed, 
are all of the devices to it. If it has none, the major header is still 
printed.

Setup This button launches the standard Windows printer setup dialog. 
You may choose a printer other than the default, or select a 
different paper size. The print program is designed to fit all 
information on Letter sized paper (8 ½ by 11) in portrait 
orientation. You may also choose Legal sized paper (8 ½ by 14). 
The print program will take advantage of the longer paper and fit 
more devices on one page for list views and correlations. If you 
choose smaller paper the font will be scaled down accordingly 
(within practical limits). 
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13.1 Print Setup

Launch the standard Windows Print Setup dialog to specify the printer, paper size and 
orientation, etc.

Figure 69 Print Setup

Pages this check box is only available when performing a print. It is 
disabled for print preview.

During preparation of a print preview or a print you will notice that 
the program makes one first pass through the tree nodes and 
loops that are in scope. It does this to calculate the page count. 
However, the program cannot insert the Max Page Number into 
the dialog because it is not known at that time.

If you need to repeat part of a print job (e.g. because the printer 
jammed part way through a job), then you must note the start page 
and the end page - up to the maximum number of calculated 
pages - and enter them in the From and To fields.

Generally, you can more easily control which portions of a job you 
wish to have printed by selecting a node in the tree and printing 
only that node.
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